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Preface

About this document

Who should read this guide?

The target audience for this guide are those who install or maintain FSM environments.

Every effort has been made to provide you with complete installation instructions. If information becomes
available after the creation of the installation media from which you accessed this guide, we will pro-
vide an updated version of the guide on the IBM/FileNet Customer Service and Support web site (http://
www.ibm.com/support). As a general rule, you should refer to the IBM web site to obtain the current version
of this guide.

This guide provides instructions for installing and/or upgrading IBM FileNet System Monitor, and identifies
the IBM/FileNet and 3rd Party products that are certified for the current release. Be aware that each release
of IBM FileNet System Monitor may have multiple Interims Fixes, or Fix Packs available for installation, each
with potentially different dependencies and installation requirements. Therefore, before you attempt to install
or upgrade IBM FileNet System Monitor, review the list of releases and their associated dependencies on
the IBM Support web site (http://www.ibm.com/support).

Before you start

Users of the guide should have knowledge about Unix and/or Microsoft Windows® operating system, web
servers, database systems and middleware platforms. The configuration of managed systems (clients)
requires advanced knowledge of all IBM ECM systems that should be monitored.

If you lack the requisite skill sets it is strongly recommended to have IBM Lab Services or a certified ValueNet
Partner install this product.

Where you find this guide

You can find this documentation on the FSM installation media in the following folder:

UNIX: <Mount point>/INSTALL/docs

Windows: <Drive letter>:\INSTALL\docs

http://www.ibm.com/support
http://www.ibm.com/support
http://www.ibm.com/support
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Feedback on documentation

Send your comments by e-mail to comments@us.ibm.com. Be sure to include the name of the product,
the version number of the product, and the name and part number of the book (if applicable). If you are
commenting on specific text, include the location of the text (for example, a chapter and section title, a table
number, a page number, or a help topic title).

mailto:comments@us.ibm.com
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Working with the Task Execution Manager

Starting the Task Execution Manager (CalaTEMa)

The Task Execution Manager needs a Java 1.4 runtime environment to be installed. On Microsoft Windows,
Java Web Start must also be installed. A JRE 1.4 including Java Web Start for Windows is available on the
Download page on the FSM web interface.

CalaTEMa is started via the FSM web interface. Start your browser and enter http://ServerName in its
address line (replace ServerName with the ip address or hostname of your FSM server).

Log in to the console and choose the Tools link in the frame on the left.

When the Tools page is displayed, choose the appropriate Task Execution Manager link.

Launch Task Execution Manager

There are two different start methods. If Java Web Start is installed (this is mandatory on Microsoft Windows),
choose the Java Web Start link. If the server detects an installed Java Web Start on the client, this is the
only link which is shown.

On Unix systems without Java Web Start, the .sh file can be downloaded and started. It uses the OpenJNLP
to start the application. The link to the shell script only appears, if Java Web Start is not installed.
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The CalaTEMa main screen

Before the Task Execution Manager starts, a login window for the cala_rex server is shown:

Login

Log in with a user that has the appropriate permission to execute tasks. The CalaTEMa window opens.

The upper part of the Task Execution Manager window shows the list of products that are available for the
user.

The Tasks combobox shows the administrative tasks for the selected product. The panel titled Task Specific
Settings changes if the task selection changes and shows the parameters for the currently selected task.



Working with the Task Execution Manager
The CalaTEMa main screen

7

FSM Task Guide Migration Tasks

Main window

The File menu

The Exit entry exits the Task Execution Manager.

The Tools menu

The View cala_rex clients ... entry shows all clients that are currently connected to the cala_rex server to
which you are logged in.

The Show environment ... entry shows the environment settings of a selected cala_rex client if a process
is executed on that client.

The Login ... entry allows you to login as another user without exiting the Task Execution Manager.
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The Add custom task ... entry allows you to create custom tasks for execution with CalaTEMa. See detailed
description below.

The Edit custom task ... entry allows you to edit tasks created by the Add custom task ... menu entry..

The Remove custom task ... entry allows you to remove tasks created by the Add custom task ... menu entry..

The Help menu

The Help entry shows global help for the Task Execution Manager.

The About entry shows version information about the Task Execution Manager.

The Show command line call button

This button displays a script with the command line call for the selected task including the given parameters.
The script can be saved to a file and can be executed manually.

NOTE The displayed script is intended to run on the cala_rex server. To run it on a client,
save the script and adjust the setting of the CENIT_ROOT variable to match the
setting on the client where the command line call must be started.

The Run task button

This button starts the currently selected task. The Task Execution Manager checks if all required fields are
filled in. If the task requires confirmation, a dialog is displayed.

The About this task button

This button shows specific help for the selected task. In this help window, you can find a short description
of the task as well as a description of all parameters.
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Creating custom tasks

The Add new task dialog

If you have the appropriate permission, you can create custom tasks.

Selecting the menu entry  Tools Add custom task ...  opens this window:

Add custom 

Product
Read-only. All custom tasks will be added to the product Custom.
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Task
Required. Specify the name of the task. The text you enter here will be shown in the Task listbox
in the CalaTEMa main window.

Command
Required. Enter the name of the command that must be executed. The command must be located
on the server where the task is executed later.

Confirm task execution
Optional. If you mark this checkbox, a confirmation window will be shown each time the new task
is started.

Arguments
Optional. Use the Add button to add new arguments. Use the Edit button to edit the selected
argument. Use the Remove button to remove the selected argument.

The Add and Edit buttons open the Add argument dialog which is described below.

Environment
Optional. Use the Add button to add new environment settings. Use the Edit button to edit the
selected environment setting. Use the Remove button to remove the selected environment setting.

The Add and Edit buttons open the Add setting dialog which is described below.

Help
Optional. Enter a help text for the new task. The help text is shown if the About this task button
in the CalaTEMa main window is pressed.

The Add argument dialog

In this dialog, you can define a command line argument for the task.
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Add argument dialog

Name
Required. Enter the name of the field. The text you enter here will be used as label in the CalaTEMa
main window.

Field has constant value
Optional. Mark this checkbox if no entry field is needed for this argument. The label of the Name
field changes to Value because the value you enter in the textfield will always be passed to the task.

Field is required
Optional. Mark this checkbox if the argument is mandatory. The task cannot be started if the field
is left empty.

Skip field if empty
Optional. Mark this checkbox if the argument need not be passed to the task if it is left empty. If you
do not check this option, an empty field will be passed for this parameter if the field is left empty.

The Add setting dialog

In this dialog, you can define environment settings for the task.

Add setting dialog
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Name
Required. Enter the name of the environment variable you need to set for the task.

Example: Custom task "Start Service"

The following example shows how to define a task that can be used to start services on Windows machines.

The task is called Start Service. It uses the net binary that is located on the Windows machine.

Example - Add custom task

Two arguments must be passed to the net command:
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The option start which is defined as a constant value:

Example - Add argument 1

The Service name which must always be specified:

Example - Add argument 2

After pressing the Ok button in the Add custom task dialog, the new task is automatically selected:
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Example - Resulting custom task
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Editing custom tasks

After selecting  Tools Edit custom task ...  a dialog is opened where you can choose the task you want
to edit.

Edit custom 

After selecting the task and pressing the Ok button, the task is loaded into the Add custom task ... dialog
which is described above.
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Removing custom tasks

After selecting  Tools Remove custom task ...  a dialog is opened where you can choose the task you
want to remove.

Remove custom 

After selecting the task and pressing the Ok button, a dialog is displayed where you must confirm removal
of the selected task.

Confirm dialog for Remove-
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Migration Tasks

Import Events from 4.0x System

Description

This task is used to import Event data from previous FSM 4.0x database into a 4.5.0 server.

This task can only run once with return code 0. After successful import of 4.0x Event data a lock file is
generated at $CENIT_ROOT/var/log. Only remove this lock file and restart this task, if you are sure Events
were not imported correctly.
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Parameters

Import Event data
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Update CalaRex

Description

This task is used to update one or more existing cala_rex Client installations at once. New agent files are
downloaded from the FSM Server to the selected clients and replaced through an agent restart.

The agent restart cannot be scheduled. The restart will be done automatically initiated after the agent files
are downloaded to the clients.

In addition, the task can connect the cala_rex and CALA client to a new server, e.g. during migration to a new
server. Note: The files logctlsrv.conf, cala_variables.txt, cmdtab_basis.tbl, cmdtab_merged.cdb (monitoring
agent configuration files) and the CALA_REX client configuration file cala_rex_cli.cfg are adjusted by the
task. A backup file for each of the adjusted files is created (added _backup to the file name).



Migration Tasks
Update CalaRex

20

FSM Task Guide Migration Tasks

Parameters

Update CalaRex

Servers
Required. Select the server(s) where the cala_rex client must be updated.

Server name
Optional. Specify the name of the new server where the CalaRex and CALA client should connect
to.

CalaRex Port
Optional. Specify the port on which the CalaRex server listens on the new server.

Event Reception Port
Optional. Specify the CALA event reception port on the new server.



Migration Tasks
Update and Install CALA

21

FSM Task Guide Migration Tasks

Update and Install CALA

Description

This task is used to install or update FSM CALA agents on selected clients.

Parameters

Update and Install 

Servers
Required. Select the server(s) where the CALA client agent must be updated.
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Update binaries
If selected in combination with the checkbox Keep monitor settings the FSM CALA binaries are
updated to the selected clients. Therefore the FSM CALA agent is stopped on the client, the new
FSM CALA agent binaries are downloaded to the client. After replacing the existing CALA agent
files on the client system the agent will be restarted.

If combined with the checkbox Keep monitoring settings the FSM CALA configuration and setup
information is not changed. This is not a complete FSM CALA installation, only the binaries will
be updated

Update monitor archives
If selected in combination with the checkbox Keep monitor settings the FSM CALA monitor-
ing archives (cepest files) are updated to the selected clients. Therefore the FSM CALA agent is
stopped on the client, the new FSM CALA monitoring archives are downloaded to the client. After
replacing the existing monitoring archives on the client system the agent will be restarted.

If combined with the checkbox Keep monitoring settings the FSM CALA configuration and setup
information is not changed. This is not a complete FSM CALA installation, only the monitoring
archive will be updated.

NOTE In some cases monitoring parameters may have been changed with the
latest version of the monitoring archive. In this case it might be necessary
to adjust monitoring settings on the updated client system.

Update configuration settings
Selecting the checkbox Update configuration settings initiates a GUI-less FSM CALA installation
that requires manual preparation of configuration files.

The chapter Preparing a MIM installation in the Mass Installation and Update
Guide describes the required manual configuration steps and required files for MIM configuration
details

Keep monitor settings
Running the task with selected checkbox Keep monitor settings in combination with checkbox
Update binaries or Update monitor archives without selecting Update configuration settings
replaces the FSM CALA binaries or monitoring archives on the specified clients.

Java installation paths
This field can contain a list of Java installation paths, separated by comma or semicolon. During
task execution on the selected client the list is searched for appropriate Java versions. The task
requires at least Java version 1.4. If no suitable Java version is found the task cannot complete
on the system.

NOTE Once the task found a suitable Java version a file .java_dir in the FSM
CALA client installation directory is stored that points to the Java location
used. Further installation with this task does not require the Java path any
longer, as long as the location of the Java installation exists.
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Combining Checkboxes ‘Update binaries‘ and ‘Update monitoring archives‘

The two checkboxes Update binaries and Update monitoring archives can be checked at once (in com-
bination with Keep monitor settings) to update the FSM CALA Agent binaries and the monitoring archives
on the clients within one step.
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Appendix A. Copyright notice

IBM FileNet System Monitor (12 March 2011)

Copyright © 2000-2011 CENIT AG, Germany; Copyright © 2005, 2011 IBM Corp., USA including this doc-
umentation and all software.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or trans-
lated into any computer language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual, or otherwise, without prior written permission of the copyright owners. The copyright own-
ers grants you limited permission to make hardcopy or other reproductions of any machine-readable docu-
mentation for your own use, provided that each such reproduction shall carry the original copyright notice.
No other rights under copyright are granted without prior written permission of the copyright owners. The
document is not intended for production and is furnished as is without warranty of any kind. All warranties on
this document are hereby disclaimed including the warranties of merchantability and fitness for a particular
purpose.

Note to U.S. Government Users Documentation related to restricted rights Use, duplication or disclosure is
subject to restrictions set forth in GSA



Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

© Copyright IBM Corp. 2001, 2010



Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.
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symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at "Copyright and trademark information" at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
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Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States,
other countries, or both.
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